
28 Creating the Model 

 

 
Virtual Airplane — third edition www.airplanes3d.net 

On the left side of the header there is a drop-down list. You can use it to select the type of the editor to be dis-

played. For example — you can display the scene structure, switching to the Outliner editor (Figure 2.1.10): 

 

   

Figure 2.1.10 Changing the window type 

Some types of Blender editors (3D View, UV/Image Editor, Text Editor) have a toolshelf, placed on the left side 

of the window. You can push/pull it using the menu command (ViewTool Shelf), but it is much easier just to 

press the T  key (Figure 2.1.11): 

 

                         

Figure 2.1.11 Flipping the Tool Shelf  visibility 

In a similar way you can show/hide the Properties shelf, placed on the right side of the window. Use just the N  

key or the menu command (Figure 2.1.12): 

 

       

Figure 2.1.12 The Properties shelf and various methods of controlling its visibility 

Press T  

You can open it 
using menu. 

This icon also opens 
the Properties shelf 

You can also flip its visibility 

by pressing the N  key. 

Outliner 

(the structure of the scene) 

From the editor type list 
select the Outliner 

You can also click this icon 
to open the Tool Shelf 
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You can change the Blender configuration in any window, switching its content to the User Preferences editor. 

This editor is available on the Editor type list (just above the Outliner item — see also page 28, Figure 2.1.10). 

Nevertheless, I prefer to invoke this window in another way: from the File menu (Figure 2.1.19): 

 

          

Figure 2.1.19 Accessing the program configuration  

On the top of User Preferences window you can select one of its sections (Interface, Editing, Input…) (Figure 

2.1.20): 

 

Figure 2.1.20 The User Preferences window 

A detailed discussion of what should be altered in the default Blender configuration can be found on page 261. 

Here I would like to indicate the option that we will need in the next section. If you use a laptop or any other non-

standard keyboard without the numeric pad — in the Input section turn on the Emulate Numpad option, as in 

Figure 2.1.20. Then save this change by pressing the Save User Settings button. (You will find it at the bottom, 

on the window header). 

Selection of the 
window section 

If you use a laptop or other computer 
without the full keyboard — turn on this 
Emulate Numpad option! 

Saves configuration 
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I am afraid that Blender can redraw this La-5 model rather slowly on many less powerful PCs. To remedy this I 

suggest to hide some layers, as shown in Figure 2.2.4: 

 

 

Figure 2.2.4 “Lighter” setup of the La-5 model — more objects are on the invisible layers 

Clicking with LMB  the “cells” of the layer control (see Figure 2.2.4), you can flip their visibility (white = invisible). 

Always do it holding down the Shift  key. If you forget it, clicking into one layer will turn off the visibility of all the 

others1. 

 
What are layers in a program like Blender? Their name comes from 2D systems. You already encountered them 

in GIMP (in Volume I, for example). In 3D programs layers lost their analogy to the surfaces that can be stacked 

on each other2.  They remained in the role of object groups that you can quickly hide or show. I often use this 

feature, placing various elements of the aircraft on different layers. Typically, while modeling a new part, I work 

on one or two layers, which contain all the required objects. For example — modeling the fairing between the 

wing and fuselage, I used three layers: one for the wings, one for the fuselage, and one for the fairing itself. 

(That is: the modeled object and the elements it has to fit between). 

 
Blender offers us 20 layers. Treat them as “containers”, in which you can keep the related objects (I will describe 

on page 242 how to do it)3.  

                                                      

1 In such a case call the Undo command — Ctrl - Z , or (in this mode) ObjectUndo. It restores the layer visibility to the state before this 

ill-fated click! 

 
2 In three dimensional space it is difficult to talk about layers that contain spatial objects, unless you are able to imagine them in the fourth 

dimension. In this case, I congratulate and envy you ! 

 
3 Frankly speaking, on the completion of this La-5 model, the number of 20 layers was a bit too small. I succeeded, however, in the end, to 

cram all its elements into these 20 "containers" in a more or less orderly manner. A detailed description of the La-5 model structure, includ-

ing its layers, can be found at http://airplanes3d.net/downloads-la5-intro_e.xml. 

This “gadget” controls the layer visibility.  

Holding down the Shift  key, click with 

LMB  its cells, to set them as follows: 

 

 ... 

... when you do it, you will 
notice that the number of 
objects, vertices and faces 
has decreased 

http://airplanes3d.net/downloads-la5-intro_e.xml
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It's time to view our model from various sides. Press the 1  key on the numeric pad (or select the ViewFront 

command) to see the front view (Figure 2.2.5): 

 

 

Figure 2.2.5 Front view (ZX) — shortcut:  the 1  key 

When you press the 3  key on the numpad (or invoke ViewLeft from the menu) — you will see the left side 

view (ZY — Figure 2.2.4). When you press the 7  key (or invoke ViewTop from the menu) — you will see the 

top view (XY — Figure 2.2.6): 

 

 

Figure 2.2.6 Top view (XY) – shortcut: the 7  key 

To see the model from the opposite side (right, bottom, rear) use the same shortcut keys, but also hold down the 

Ctrl  key: 

- right side view: Ctrl - 3  (ViewRight); 

- bottom view: Ctrl - 7  (ViewBottom); 

- rear view: Ctrl - 1  (ViewRear); 

 

 On the computers without the numpad, set the Emulate Numpad option (see page 32) and use the keys 

with numbers, from the row located below the function keys (below the F1 .. F12 ). 

 

The plane of 
this view: ZX 

The plane of 
this view: XY 
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Figure 2.2.6 does not display the entire airplane. To zoom it out, press the  -  (minus/dash) numpad key, two or 

three times (or invoke the ViewNavigationZoom Out command, but it is less practical):     

 

 

Figure 2.2.7 Zooming 

Similarly, pressing the  +  numpad key zooms it in (ViewView NavigationZoom In). There is also a Home  

shortcut. It sets up such a magnification that you can see all the scene objects in the active window. 

 
You can also zoom using the mouse. Roughly — by rotating MW .  (It invokes exactly the same commands as 

the  + /  -  shortcuts). Precisely (smoothly) — holding down Ctrl , press MMB  and drag the mouse up or down. 

 
How to pan the view? Roughly – Ctrl - 8  or Ctrl - 2  (up or down), Ctrl - 4  or Ctrl - 6  (left or right). It is not so diffi-

cult to remember — notice, that on the top of the 8 , 6 , 2  and 4  numpad keys you can see adequate arrows! 

To pan precisely (smoothly) — holding down Shift  press MMB  and drag the mouse, so the view will follow this 

movement (Figure 2.2.8).    I always use the mouse to pan the view in Blender1! 

 

 

Figure 2.2.8 Panning  

                                                      
1 Yet another method is a "jump" to specified point on the screen. You can use the 3D Cursor (see pages 55, 272) for this purpose, invoking 

the ViewAlign ViewCenter View to Cursor command ( Alt - Home ) 

To zoom the view smoothly – holding 

down Ctrl  and MMB  move the 

mouse up or down  

To pan the view smoothly – holding 

down Shift  and MMB  drag the 

mouse. The view will follow this 
movement. 
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Photographs have accustomed us to the perspective projection — so let's turn it on. Just press the 5  numpad 

key (ViewPersp/Ortho) – and here it is (Figure 2.2.11):    

 

 

Figure 2.2.11 Initial perspective projection (with a strong “fisheye” distortion) 

Well, it seems that the perspective distortion is too strong in this case (Figure 2.2.11) — this airplane looks like 

through a wide-angle lens! Can we do something with it? 

 

Sure! Press the N  key (ViewProperties) to open the Properties shelf (Figure 2.2.12a). If the Blender controls 

visible in this pane looks a little bit strange for you — take a look at page 64, where they are described. 

 

                  

Figure 2.2.12 The Properties toolbox and its View panel 

At the top of Properties pane you can see the Transform section (panel). It displays some of active object prop-

erties (you will learn in the next section what the “active object” is). We do not need them at this moment. Below 

there are more, initially invisible, panels. Move the slider of this shelf down to see the View panel (Figure 

2.2.12b). (When necessary, you can reorder panels of this toolbox, so that View will appear on its top — see 

page. 61). 

Press N  to open this 

toolbox 

These are the active 
object properties: not 
important at this 
moment. 

Scroll the toolbox 
down 

The View panel 
contains properties 
of this 3D View 
 

a) b) 
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The View pane contains properties of the current projection. Increase its Lens value from 35 to 70 units.  (Lens 

is an numeric field — in case of doubts on how to use it, take a look at page 66). With such longer lens the air-

plane is less distorted, but it appears too close, so you can see only a part of this model. Zoom it out a little – 

using the  -  numpad key or scrolling the MW . Figure 2.2.13 shows the result: 

 

 

Figure 2.2.13 Adjusted perspective view (with increased Lens value) 

Notice the “penetrations” that have appeared on the model surface. These are faces of the interior objects, 

which in the real world would lie 1 - 2mm (0.05 - 0.1 inch) below the surface of the airplane. (This is the thick-

ness of sheet metal or plywood sheathing). They were not visible in the axonometric projection, and will disap-

pear when you zoom in the view. Yet this effect is very ugly. How to get rid of it? 

 
It turns out that it is enough to change another property in the View panel. When you increase the Clip:Start 

value (for example to 0.1), the “penetrations” of the inner faces will disappear (Figure 2.2.14): 

 

 

Figure 2.2.14 Adjusted perspective view — increased the Clip:Start value 

(The previous Clip:Start value was ten times lower — see it in Figure 2.2.13). 

The inner faces "break through" 
from underneath of the model 
surface 

Change 
the lens to 
70 
 

Increase 
the Start 
value 
 

“Penetrations” 
have disappeared  
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If you want to return to the axonometric (orthogonal) projection — press the 5  numpad key again (it acts like a 

switch). You can also invoke the ViewPersp/Ortho menu command. 

 

In the perspective view you may encounter a phenomenon which I call “invisible wall”. To see what I mean, try to 

zoom in the pilot cockpit (Figure 2.2.15): 

 

                                  

Figure 2.2.15 The “invisible wall” effect during zooming (perspective projection) 

Set this part of the model in the middle of the 3D View window and start to rotate MW  forward (Figure 2.2.15a). 

Initially, you will have an impression that you are rapidly approaching the model. However, gradually this move-

ment is becoming more and more slower. Finally you will reach the state, in which any further rotation of MW  

changes nothing (Figure 2.2.15c). What's more, you cannot pan this view ( Shift - SPM ) either! 

 

What is the reason for such a strange effect? Well, in perspective projection each view has its focal point, locat-

ed at a distance from the screen plane. Zooming in the perspective view  reduces this distance (Figure 2.2.16): 

 

 

Figure 2.2.16 The reason of the “invisible wall” effect 

When you rotate the MW  forward (or press the +  key on the numeric keypad) Blender reduces the distance 

between the observer and the focus by the 1/6 of its current length. This means that the closer you are to that 

point, the slower you are moving, and finally you will stuck on a distance close to zero (as in Figure 2.2.15c). 

Unfortunately, Blender does not offer any direct command to shift the focal point of a perspective view into a 

new, more distant location! 

Rotate MW  Rotate WM  

 But at some point you cannot 
get closer anymore! 

a b c 

The view 
focal point 
 

The view 
plane (a) 
 

View lens:  
70 mm  
i.e. 25.75º 
 

Locations of the view plane, 
corresponding subsequent 

rotations of the MW  

 

The “invisible wall” 
is near here 
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Fortunately, we can move the view focus in an indirect way. When you encounter the “invisible wall” during 

zooming, go back a little bit (i.e. decrease the magnification, for example by pressing the -  key several times) to 

increase the current distance from the screen to its focal point. When you are able again to pan the screen with 

ease, press Shift - F  (ViewNavigationWalk Navigation — Figure 2.2.17a): 

 

                                

Figure 2.2.17 Using Walk Navigation to shift the current view and its focus 

In this mode you can move around Blender scene as in games: press W  to move forward, S  to move back, A  

— to the left, D  — to the right. Move the mouse to “rotate your head”, determining the view direction. Thus to 

pass through the “invisible wall” of a perspective, keep pressing the W  key to move the focal point along the 

axis perpendicular to the current view plane. To accelerate this movement you can rotate the MW  once or twice. 

When you are close enough to the desired object — click LMB  to complete this operation (to confirm this new 

projection). If something went wrong — you can always press Esc  to cancel it. This is the quickest way to over-

come the “invisible wall” effect. (That's why you had to move the view back a little, before — to create a suffi-

cient distance before this operation). 

You can find all the commands we have discussed in this section in the ViewNavigation submenu. If you can’t 

remember their keyboard shortcuts, you can use the contents of this menu as the hint (Figure 2.2.18): 

 

 

Figure 2.2.18 Commands from the View menu  

Hold down the 

W  key …  

…then press 

LMB  to 

complete this 
operation  

… the view begins to move 
toward the center … 

In the Walk Navigation 
mode move around the 
scene using the same 
keys as in games: 

… and finally you are 
where you want, and the 
view is not locked! 

a b c 

… release W  

when you are 
close enough… 

To make the 
movement faster, 

rotate KM  once 

or twice…  

Such a cross 
appears in the 
middle of the 
view 

W  

A  S  D  
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Summary 

 Elements of a complex model are placed on different layers. Switching these layers on and off, you can 

quickly control the visibility of the objects you want to work with (page 38);  

 To quickly set one of the orthogonal views, use following shortcuts: 1  (front), 3  (left side), 7  (top). To view 

the scene from the opposite direction — hold down also the Ctrl  key: Ctrl - 1  (rear), Ctrl - 3  (right side), 

Ctrl - 7  (bottom) (page 39); 

 To rotate the view: drag the mouse with the MMB  pressed (page 41); 

 To pan the view: holding down the Shift  key, drag the mouse with the MMB  pressed (page 40); 

 To zoom the view: holding down the Ctrl  key, drag the mouse up or down with MMB  pressed (page 40); 

 Switching the current projection between the axonometric and perspective: use the 5  key (page 42); 

 You can change the projection parameters (for example — the lens of the perspective projection) in the 

Properties pane ( N ), on the View panel (page 43); 

 When you zoom in the model in a perspective view, you can come across the “invisible wall” effect (page 

44). Use the Walk Navigation ( Shift - F ) command to overcome this issue (page 45). 
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2.3 3D View — cameras and object selection 

There are more ways to view the model than we have discussed in the previous section. To see another one, 

press the 0  (“zero”) key (ViewCamera): 

 

 

Figure 2.3.1 Camera View 

Figure 2.3.1 shows the view from the active camera. Blender will use this projection to create the final render or 

animation.  

What is a camera in Blender? It is a special kind of object, which you can insert into the scene. This La-5F sce-

ne contains two cameras. Press 1  and adjust the zoom, to see both of them (Figure 2.3.2): 

 

 

Figure 2.3.2 Two cameras of the La-5 scene 

The border of the 
rendered area  

A camera, name: 
Camera.Tracked 
 

A camera, name: 
Camera.Static 

 

a) 

b) Enlarged view 
of the camera 
object. 

I have zoomed this camera object, so you can see its 

details. In most projections it is so small that almost 

reduced to a point. 
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You can move these cameras — just like in a real studio. Before we start doing it (page 51), we will learn how to 

select objects. It is the first step of every Blender operation.  

 
Click the RMB  onto the right camera. In response Blender highlights it (Figure 2.3.3):  

 

 

Figure 2.3.3 Selected object (a camera) 

The selected object has changed its color to pale pink. This way Blender marks the last “clicked” scene element. 

You can see its name in the lower left corner of the 3D View. This is the current active object. (The active ob-

ject is the last selected object). 

Press the A  key (SelectSelect/Deselect All) now to deselect everything. (This command “clears” current 

selection, when it exists, or selects everything, when nothing is selected). Notice that the active object name is 

still on the screen (Figure 2.3.4): 

 

 

Figure 2.3.4 The last selected object remains active 

The active object plays important role in many Blender operations — for example in the Parent command, which 

creates the object hierarchy (see page 306). 

The clicked object has 
become pale pink 

This object is no longer selected, but it 
is still the active one. 

Its name is still visible in the lower left 
corner of the window, and the origin of 
this object is still highlighted 

Active object name. (The last “clicked” one).  
In parentheses — the number of its layer. 
 

Click it with RMB      
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To include an additional object to the current selection set, hold down the  Shift  key while clicking objects with 

the RMB . In order to better learn how it works, I suggest you make a few quick experiments. 

 
Start them when nothing is selected. Hold down the  Shift  key and execute the sequence of operations listed by 

Table 2.3.1. (You can find the camera names on page 47, Figure 2.3.2): 

 

Holding down the Shift  key: Result 

Selected objects and their colors Active object 

Click with RMB  into Camera.Static Camera.Static (pale pink) Camera.Static 

Click with RMB  into Camera.Tracked Camera.Static (pink) 

Camera.Tracked (pale pink) 

Camera.Tracked 

Click with RMB  into Camera.Static Camera.Static (pale pink) 

Camera.Tracked (pink) 

Camera.Static 

Click with RMB  into Camera.Static Camera.Tracked (pink) Camera.Static 

Table 2.3.1 The active object and the selected object — some experiments with the group selection in Blender 

I will not show the results of the operations listed in Table 2.3.1 on the pictures. The standard adjustments of 

their contrast and brightness cause the loss of subtle differences between the two colors of the selection: the 

pale pink (active object) and the pink (other selected objects). The conclusion of these experiments is as fol-

lows: 

- The  Shift  key modifier serves not only to include, but also to exclude an object from the current selec-

tion set. (When you click an object for the second time, it becomes the active one, and when you do it 

for the third time — it is no longer selected); 

- The active object can be out of the current selection (see the last row in Table 2.3.1); 

 

You can also select a group of the objects using a rectangular area. Press the B  shortcut (SelectBorder 

Select). In this mode two crosshair lines appear at the mouse cursor. Move the cursor to the place where you 

want to have the first corner of the selection area. Press the LMB  and hold it down while dragging the mouse 

(Figure 2.3.5). It will drag the opposite corner of the selection rectangle. Locate it in the proper place, and re-

lease the LMB . It selects all the objects that are inside this area (also the ones that lie across its borders). 

Border Select command does not alter the current active object. 

 

 

Figure 2.3.5 Selecting objects with the rectangle (Border Select) 

To exclude the objects inside this rectangle from the current selection, after invoking Border Select command 

(the B  key) use MMB  instead of LMB .  

 

...and release   LMB .    

Press LMB  ... 

...drag the mouse...  
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The Select menu of 3D View window contains many other commands, such as selection by the layer, or by the 

object type (Figure 2.3.6): 

 

 

Figure 2.3.6 Other selection commands, available in the Select menu. 

 You can find description of few other useful selection methods on page 322. 

 

Summary 

 To display the view from the active camera in current window — press the 0  key (ViewCamera) (page 

47); 

 To select an object, click it with RMB . Hold down the Shift  key, to add it to the previously selected objects  

(page 48); 

 To select objects using a rectangle — press the B  shortcut (or invoke the SelectBorder Select com-

mand). Then press the LMB  in the first corner of the rectangle, and drag the mouse to set the opposite cor-

ner. To exclude objects from the current selection — begin in the same way ( B ), but use the MMB  instead 

of the LMB  (page 49); 

 Blender distinguishes the last clicked (with the RMB ) object from the rest of selection. It is referred as the 

active object, and its name is displayed in the lower left corner of the 3D View window (page 48); 
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2.4 3D View – object movement and rotation 

In this section I will show how to change the location and orientation of the active camera (it is also an object). 

However, before that: 

- select the Camera.Tracked object. It is the active camera of this La-5 scene. Make sure that you can 

see its name in the lower left corner of the 3D View window; 

- tile the active 3D View ( Ctrl  –   or Area OptionsTile Window), and join two other windows, leaving 

just two views on the screen. In one of them set up the camera view ( 0 ), in another — the front view 

(Figure 2.4.1). We will work in the left window, simultaneously observing changes in the right one: 

 

 

Figure 2.4.1 Screen layout, proposed for this section 

Press the G  key (or ObjectTransformGrab/Move). From now every movement of the mouse moves the 

selected object (the camera, in this case). Notice the changes in the camera view window (Figure 2.4.2): 

 

 

Figure 2.4.2 Moving the object 

During this operation Blender shows in the active 3D View window header current X,Y,Z coordinates and the 

length (in parentheses) of the offset vector. Click LMB  to accept current location of the object, and finish this 

movement. (To cancel this operation, press the Esc  key). 

Selected camera 

The name of the camera 0 : Camera view 

Move the camera 
object… 

Current displacement vector and 
the distance (in parentheses). 

... so the view 
from this camera 
dynamically 
changes! 
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How does it happen that during this movement the camera is keeping the aircraft in the center of its view? Be-

cause it is tracking this model. I will describe how to create such a link later in this book. Now I would like to 

demonstrate what is actually tracked by this camera. 

 
To show this “target” object, we have to hide some 

layers, and enable the others. However, you may 

encounter a problem (at least on the smaller dis-

plays): there is no visible layer indicator on the 3D 

View window headers! Each pane in this tiled 

screen layout is so narrow that this control is hid-

den somewhere beyond the window edge. 

Little secret: you can move the window headers in 

Blender, just like you pan the 3D View scene. Just 

place the mouse cursor over a header, and press 

MMB . Holding it down, drag the mouse left or right. 

Can you see that the entire header is moving? Shift 

it to the left, to make the layer control visible 

(Figure 2.4.3). 

 
Now turn off layer 11 and turn on layer 10. Oh, I have to introduce the concept of layer numbering! To keep the 

explanation short, let's assign to each layer the following numbers (Figure 2.4.4): 

 
 

 

Figure 2.4.4 Numbers assigned to Blender layers 

Thus flipping the states of layers 11 and 10 gives following layer visibility: . Turning off layer 11 hides 

the wings and the middle and rear part of the fuselage. Layer 10 is one of the two layers that contains the auxil-

iary “control” objects, not intended to appear on the final render. (Another layer in this scene that groups such 

objects is layer 9). Now you can see in the place of the invisible wings of our model the slots, ailerons and flaps, 

and in the place of invisible tail plane — its rudder and elevators (Figure 2.4.5): 

 

 

Figure 2.4.5 The Camera.Target object — the focal point of our camera 

Somewhere in the cockpit area there is a relatively large, red cylinder. It is named Camera.Target. Select it (see 

Figure 2.4.5). 

 

Figure 2.4.3 Shifting the window header 

The focal object of the 
camera — Camera.Target 

This is the armature 
(“bones”) used for the 
animation of the pilot 
figure. (It is one of the 
objects from layer 10) 

Holding down the MMB  drag the 

mouse over the window header — 
this will move it left or right 

1 2 3 4 5  6 7 8 9 10 

11 12 13 14 15  16 17 18 19 20 
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Let's say that we would like focus our camera on the engine area instead of the cockpit. To place it there, you 

have to move the Camera.Target object along the Y axis. You can do it in any view projection, even in the per-

spective.  

 
Press the G  key to shift the selected object. Immediately afterwards press the Y  key – it restricts the current 

movement to this axis. The Y axis has become white, and the information displayed in the window header is 

different — it shows a value of the single Y coordinate. Now, every mouse movement shifts this object along the 

Y axis as on a wire (Figure 2.4.6): 

 

 

Figure 2.4.6 Constrained object movement (along the Y axis) 

As you can see, the camera keeps the Camera.Target object in the center of the window. Do not end this 

movement yet. I will show you another effect: while dragging the mouse, hold down the Ctrl  key. Do a relatively 

long move. Now you will see that the object is moving in steps of 10 units (Figure 2.4.7): 

 

 

Figure 2.4.7 Moving the object by regular steps (holding down the Ctrl  key) 

 Holding down the Ctrl  key during every transformation (moving, rotating, scaling) changes the values being 

transformed stepwise, by a fixed increment.  

 
(I have shown the Ctrl  key in action during the shifting of an object along Y axis just as an example. You can 

use it in any transformation).  

Here you can see that the Z 
and X object coordinates 
remain unchanged.  

Hold down the Ctrl  key during 

this operation, to move the object 
in fixed steps of regular length  

The path of this movement 
— the global Y axis. 

Shifted object 
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Why does the basic “step” of the object movement in this window have a length of 10 units? It depends on two 

factors: the current magnification and the 3D View projection. Cancel the current operation ( Esc ) and start it 

again but in the left side view (the lower left window depicted in Figure 2.4.7). When you hold down the Ctrl  key 

here, the basic step of the object movement will have length of 5 units – two times less, than in the perspective 

view. It seems to be a general rule – in 3D Views with the “orthogonal” projection (from the top, side, or the 

front..) these steps are smaller. This is the approximate distance between the nodes of the helper grid, which is 

displayed by the 3D View. When you zoom in the view, its grid is getting denser. Simultaneously the basic 

movement step forced by the Ctrl  key decreases, respectively, from 5 to 1 unit. 

 
Now another effect: hold down the Shift  key while dragging this camera. What happens? The same mouse 

movement causes a smaller displacement of the dragged object! 

 

 Holding down the Shift  key during every transformation (moving, rotating, scaling) reduces the “influence” 

of the mouse. (The same mouse movements cause smaller object displacements on the screen). It makes 

easier to set precisely the object onto its final place.  

  

What happens when you hold down the Ctrl  and Shift  keys simultaneously? We will obtain a stepwise move-

ment that has its basic step ten times smaller. In the camera view it decreases the basic translation step from 10 

units (the Ctrl  key down, only), to 1 unit (both Shift  and Ctrl  keys down). 

 

I would like to show the object rotation with an example in the side view. Yet there is a small problem — the 

object to be rotated is obscured by the wing flap. Let's say that you do not want to turn off the visibility of the 

layer containing that flap, because you would miss the contour of the wing trailing edge in this way. In such a 

case you can alter the way in which Blender draws the contents of this window, switching it from the Solid to the 

Wireframe mode. Select the Wireframe as the current drawing mode from the Viewport Shading dropdown list. 

It is located on the 3D View window header (Figure 2.4.8): 

 

 

Figure 2.4.8 Changing the Viewport Shading mode 

Figure 2.4.9 shows the result of changing the shading mode. As you can see, it is an individual setting of each 

window. (The right window still uses the Solid shading on this illustration). 

 
In practice, the Solid and Wireframe modes are used most often. The third method of shading (Textured) will be 

used later in this book — when we deal with textures. 

This object in the 
current shading mode 
(Solid) is obscured by 
the wing flap... 

...so let’s switch into  
Wireframe shading mode! 
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How to rotate an object? In a similar way to object movement: press the R  key (ObjectTransformRotate) 

to start the rotation (Figure 2.4.9): 

 

 

Figure 2.4.9 Rotation (around the origin of selected object) 

By default, the object is rotated on the current screen plane. The window header shows the current rotation 

angle. You can also force the rotation around any of the X, Y, Z axis, by pressing one of these keys on the key-

board ( X , Y , or Z ).  

The rotation of the Camera.Target object also rotates the camera (see the right window). This follows from the 

fact that the camera is “tracking” this object, so the local Z-axis of the camera points always in the same direc-

tion as the local Z-axis of Camera.Target. You can also use the Shift  key while rotating, to obtain a precise 

rotation, by fractions of a degree. Use the Ctrl  key to rotate by angle increments of 5º, and Shift - Ctrl  to rotate 

by increments of 1º. 

 
If you want to rotate around other point than the origin of 

selected object, you have to use the 3D Cursor.  

You know the role of the flashing caret in any text editor. It 

shows the place where the new text will be inserted, if you 

start to type. This concept was copied into the 3D world. In 

Blender there is also such a special point, which you can 

place anywhere in the scene. They also named it cursor, 

but with the 3D prefix. It marks the location where the new 

object will be placed, if you create it at this moment. It can 

also serve as the pivot point in such operations as rotation 

or scaling. 

 
3D cursor is drawn as a small cross, surrounded by the 

red and white circle (Figure 2.4.10). You can put it any-

where, clicking the LMB  in the desired place of the scene. 

You can also force it to move to the nearest grid point. To 

do this, press the Shift - S  shortcut (Object to Snap) and 

from the menu that appears, select the Cursor to Grid command (Figure 2.4.10).  

 
This second step — selection of the menu item — you can do also with the left hand, pressing the 6  key. (The 

“6” is the position of the Cursor to Grid command in the Snap menu, counting from the top).    

  

Figure 2.4.10 3D Cursor and the Snap context menu 

The pivot point — the 
origin of the object 
being rotated 

Current rotation 
(in degrees) 

When you rotate the 
camera target — the 

camera also rotates 

3D cursor 

You can use the Snap 
menu commands to 
precisely place the 3D 
Cursor in the scene space 
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To rotate the Camera.Target around any spatial point, place the 3D Cursor (with a LMB  click) in appropriate 

point on the screen. (You will often have to set its location in two perpendicular views. The Snap menu com-

mands are also helpful in such a case).  

 

Then switch Blender into the mode that uses the 3D Cursor as the reference point. To do it, use the Pivot 

dropdown, from the 3D View window header (Figure 2.4.11). Select the 3D Cursor option from this list (or press 

.  on the keyboard): 

 

 

Figure 2.4.11 Changing the Pivot mode to 3D Cursor 

Make sure that the Camera.Target object is still selected. 

 

The remaining steps are the same as before — press the R  key and rotate the object (Figure 2.4.12): 

 

 

Figure 2.4.12 Rotation around the 3D Cursor point 

When you finish, set the Pivot Point back to the Bounding Box Center mode ( , ). Alternatively, you can also 

switch it into the Individual Centers mode ( Ctrl - . ). 

 

2. From the Pivot Point list 
select the 3D Cursor 

Camera.Target is 
still selected 

1. Place 3D Cursor here 

The center of 
this rotation is 
in the 3D 
Cursor point 

Camera.Target — 
the rotated object 
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I will not describe here the last one of the three basic object transformations: scaling. So far I have tried to dis-

cuss each topic in a way that allows you to immediately use the acquired knowledge. For example, by rotating 

and moving Camera.Target and Camera.Tracked objects you can arrange for the render a new projection of 

the La-5 model. (I will introduce rendering in the next section). Unfortunately I did not find in this scene and at 

this point of narration any useful application of scaling. I will only mention that changing an object size is very 

similar to the rotation. The reference point is also determined by the Pivot Point mode. It can be the object origin 

or 3D cursor. To start the scaling operation, press the S  key (ObjectTransformScale). More on this sub-

ject you can find on page 291. 

 
If you want to type exact numerical values of ob-

ject transformation instead of using the mouse, 

press the N  key to open the Properties pane 

(ViewProperties).   On its Transform panel 

(Figure 2.4.12) you can find the current Location 

coordinates, Rotation angles and Scale coeffi-

cients of the active object. If you rotate the active 

object with the mouse, Blender will update the 

values displayed in this panel “on the fly”. It also 

works in the opposite: when you enter a new val-

ue into one of the Transform panel fields, you will 

immediately see the effect of this change in all 3D 

View windows. 

Note that each of the transformation fields has a 

lock icon ( ) in the Properties pane. When its is 

clicked — the coordinate of this field is excluded from the changes applied during object transformations. It is 

very convenient when you want to resize an object only in the one plane — let's say XZ. Before this operation 

lock the Dimensions:Y or Scale:Y field. Then, when you start the scaling operation ( S ), which usually resizes 

everything uniformly in all directions, the object size along the Y axis will remain unchanged. 

 
During transformation (rotation, translation, scaling ...), you can also enter exact numerical values of their pa-

rameters. Just press the =  key (Figure 2.4.14): 

 

                          

Figure 2.4.14 Switching into manual entering of transformation input values 

Blender places a text caret in the first field of the transformation parameters. Now you can enter a new value 

typing it on the keyboard. To shift caret to the next field, press Tab  (Figure 2.4.15). Press Enter  to complete this 

transformation, or Esc  to cancel it. 

 
 

 

 

 

Figure 2.4.15 Entering exact numeric values of the transformation parameters 

 

Figure 2.4.13 Properties of the active object 

Blender displays here 
parameters of the 
current transformation 
 

Press =  

You can also enable this 
mode by typing (entering) 
any digit on the keyboard 

A vertical caret appeared in the first of 
the parameters — here you can enter 
an exact value of the Dx. 
 

You can see the entered value here.  It 
is also possible to enter a Python 
expression, e.g. “1-cos(3*pi/180)” 
 

In these parentheses 
Blender displays the length 
of the current displacement 
 

To move to the next transformation 

field, press Tab  

 

Here you can enter an exact 
value of the Dy 
 

Tab  

Active object 
properties 
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In the Properties pane you can also check or 

change the exact coordinates of the 3D Cursor. 

Just scroll the content of this toolbox upward to 

expose the 3D Cursor panel. Then inspect or 

update its Location values (Figure 2.4.16): 

 
Finally, let's talk about what to do when you have 

made a mistake and you want to revert your sce-

ne to the state before the last operation. Like the 

most editors, Blender provides multiple Undo and 

Redo levels. These two operations are so im-

portant that I have put their shortcuts in the boxes 

below. (To make them more visible when some-

thing has gone wrong in your Blender scene). 

 

 

 Undo – reverting the last operation: press the Ctrl - Z  keys (or invoke the ObjectUndo command). 

 

 Redo – reverting the last Undo: press the Ctrl - Shift - Z  keys (or invoke the ObjectRedo command). 

 
It is worth mentioning that the Object menu is present on the 3D View header only in the Object Mode, which we 

are currently using. There are also other modes, like the Edit Mode (edition of a single mesh), which we will 

discuss later. In these other modes you will find different menus on the 3D View header, in place of the Object 

menu (for example — Mesh, in the Edit Mode). In each of them there are Undo and Redo commands. Yet it is 

better to remember their keyboard shortcuts. In some other editors, like UV/Edit Image, you will not find these 

commands in the Image menu, nor in any other menu. (It seems to be an error in the user interface design). 

Nevertheless the Undo and Redo are still available there — you have to invoke them using their shortcuts. 

 
Our introduction to Blender fundamental transformations ends here.  There are obviously many other transfor-

mations in this program — as you can see in the Object menu (Figure 2.4.17): 

 

 

Figure 2.4.17 Transformations available in the Object menu 

Do not worry about the operations which have unfamiliar names. We will not need many of these commands to 

build our model! I will introduce all the tools that I use in the following chapters of this book. 

 

Figure 2.4.16 View properties: 3D Cursor location 

Current 3D Cursor 
coordinates 
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Summary 

 Translation – the G  key (Grab/Move — page 51); 

 Rotation – the R  key (Rotate — page 55, 56); 

 Scaling – the S  key (Scale — page 57); 

 Hold down Ctrl  during transformation, to change object coordinates in the regular, fixed steps (page 53); 

 Hold down Shift  during transformation for the additional precision of the mouse (page 54); 

 You can restrict every transformation to a single axis, by pressing the X , Y , or Z  key (page 53). It allows 

you to use these transformations even in the perspective view! Note: when you press the axis letter twice, 

the movement will be restricted to the local object axis. Pressing such a key for the third time switches 

Blender back to  the free movement on the current view plane. 

 You can set the pivot point, used in rotation and scaling, to: .  = 3D Cursor, ,  = Bounding Box (page 56); 

 To cancel current operation – press Esc  (page 51, 54) 

 To Undo the last operation – Ctrl - Z  (page 58).  

 To Redo the last Undo operation – Shift - Ctrl - Z  (page 58); 
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2.5 Properties window 

At the end of this chapter I would like to show you how to obtain the final effect — a rendered image of the La-5 

airplane. To do it, you will need to click some buttons, and switch some options in the Properties window. This 

window is located by default on the right side of the Blender screen (Figure 2.5.1):  

 

 

Figure 2.5.1 Main elements of the Properties window 

In this window Blender exposes properties of the current scene, active object, its material and textures, etc. At 

first glance, it teems with checkboxes, buttons, and other controls. I will start by explaining its key concepts and 

elements. In the header of this window you can see the context (panel set) selector. Below you can see the 

current datablock (see page 393 to learn what the datablock is) — this is the name of the “thing” that owns the 

properties displayed below. (In the example, shown in Figure 2.5.1, this is the current scene, named Airborne). 

Below you can see panels that group the controls by their “subject” (Render, Layers, Dimensions, … — Figure 

2.5.1). 

On the top of each panel there is the header with the label (panel name). On the left side of the header you can 

see a triangle that folds and unfolds the panel (Figure 2.5.2):  

 

                           

Figure 2.5.2 Folding and unfolding the panel 

A single panel 

Current 
datablock 

Context (the panel set) selection  
 

Panel header 

Click LMB  here 

to fold (collapse) 
the panel 

Click LMB  here to 

unfold collapsed panel 
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On the right side of the panel header there is a handle. You can “grab” it with LMB  and drag this panel into an-

other place (Figure 2.5.5): 

 

                 

Figure 2.5.3 Moving the panel 

The positions of all panels (and in general — the whole state of the user interface) are saved together with the 

scene state in the Blender file. (When you open a Blender file, everything on its screen will look exactly as in the 

moment of the last invocation of the FileSave command. It is very convenient). 

 
In many contexts the panel stack is longer than height of the screen. To reach the panels located below, you 

have to scroll the content of the Properties window. Do it with the slider (Figure 2.5.4a), placed at the right edge 

of this window, or just holding down the MMB  and dragging the mouse up or down (Figure 2.5.4b): 

 

                                                       

Figure 2.5.4 Two methods of scrolling the contents of the Properties window 

“Grab” this handle 

with LMB  … …holding down LMB  

drag it into another place… 

…and release it here! 

“Passed” panels dynamically “jump” below  

Move the 
window slider 

Hold down MMB  

and drag the mouse 
vertically 

a) b) 
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The Properties window has so many panels that it is virtually impossible to use them all at the same time  (You 

would have to scroll the window up and down too often). Fortunately you do not have to do it in this way. You 

need different panels for modeling, others for working with materials and lighting, yet others — to render a sin-

gle image or animation. That’s why the panels in the Properties window are divided into several sets (contexts), 

corresponding to these typical operations. Use the icon buttons, located on the window header, to switch be-

tween different panel sets (Figure 2.5.5):  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2.5.5 Typical contexts of the Properties window 

Figure 2.5.5 shows the typical combination of the panel sets. This is the header of the Properties window, dis-

played for a typical geometric object. Figure 2.5.5a) describes the panel sets that are always present in the 

Properties header, regardless of the active object type. These are the first five sections from the left: Render, 

Scene, Word, Object, Object Constraints, and one from the right: Physics. Figure 2.5.5b) enumerates sections 

specific for an geometric object. (Such an object contains so called mesh — a datablock representing its sur-

face, built of faces, edges, and vertices).  

 
By the way — note, that in Figure 2.5.5a) you can see a different datablock (the Airborne scene) than in  Figure 

2.5.5b). This is despite the fact that the active object on this scene was the same in both cases. (It was the 

012.Body object). Try to select some other contexts, and you can see further differences (Figure 2.5.6): 

 

       

Figure 2.5.6 Current datablock depends on the selected context 

When you select the Object context, Blender will display the active object as the current datablock (Figure 

2.5.6a) — this time without the mesh (Figure 2.5.5b). When you select the World context, it displays the envi-

ronment datablock (named World) that contains the active object. For the same reason when you select the 

Render context, you will see the datablock of the scene, that contains the active object (comp. Figure 2.5.5a).  

 

 The panels in the Properties window always show details of the datablock 

displayed below the window header.  

 
If you want to see properties of a particular datablock, regardless of the current 

active object selection, use the “pin” to attach it to the header (Figure 2.5.7). Just 

click this icon to keep it in the Properties window all the time. To detach this data-

block, “unpin” it in the same way. 

 

Figure 2.5.7 Datablock “pin” 

Current datablock: scene 
environment (World), 

containing the active object 

Current datablock: the 

active object (012.Body) 

Current datablock: 
scene (Airborne) 
 

Render: generation of the final image or animation  

Scene: details of the current scene 

World: environment settings (background, etc.) 

Object: active object 

Object Constraints: helps 
to pose objects or the 
camera (tracking its target) 

Phisics: simulation of the 
physical world (gravity, 
inertion, etc.).  
 

These sets depend on the 
type of active object 
 

Object Data: in this case —
Mesh properties 

Current 
datablock: 

012.Body 

Modifiers: invertible changes 
of the mesh shape 

Material: color, 
shininess…  

 
Texture: images of the 
surface details 

 

Particles: 
smoke, fire, and 
other effects 

 

a) b) 

Contexts specific for the Mesh object  

(i.e. a geometric object) 

 

a) b) 

Use this „pin” to 
keep displaying 
this datablock 
regardless of the 

current selection 
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There are also other types of objects that do not contain the meshes: for example light sources (Lamps), or 

cameras. Figure 2.5.8a) shows the panel sets displayed for a Lamp, and Figure 2.5.8b) — for a Camera: 

 

           

Figure 2.5.8 Various Object Data icons for different kinds of objects 

As you can see, the Object Data set that has the “triangle” icon for the mesh objects (see Figure 2.5.5b), for the 

lamp data displays a “sun” (Figure 2.5.8a). The camera icon in Figure 2.5.8b) also speaks for itself. Note that 

neither the camera nor the lamp have the Particles and Material icons. The cameras do not have the Textures 

icon, either (because they do not need them). 

 
Table 2.5.1 provides a summary of panel sets which we will use in further chapters of this book:  

 
Context Description 

 Render 
All the render parameters. At the end of this section I will show it in action. 

 Scene 
Scene parameters, like the active camera, or an assignment of another scene as the background picture. 

The Handle Panel add-on that we will use to “pose” the model, also adds its panel to this section. (This 

Blender plugin controls opening and retracting of the landing gear, flaps, movements of the rudder, eleva-

tor, and ailerons, etc.). 

 World 
The parameters of the scene environment (for example the color or texture placed on the background, the 

intensity of the global, dispersed light, etc.) 

 

 Object 

 

Active object properties: current location, orientation, name, and many others (for example: assigned 

layers).  

 Object Constraints 

 

Manages the object constrains. (You can assign a constraint to any object. For example — the 

Camera.Tracked is directed automatically on the La-5 model, because it has a Track To constraint. This 

constraint always directs selected camera axis onto the auxiliary Camera.Target object). 

 Modifiers 

 

This section is displayed for geometric objects only (i.e. the objects that contain the mesh datablocks). 

You can apply here some additional, “reversible” effects, like smoothing with subdivision surface, or bend-

ing along a curve 

, , , … 

Object Data 

Properties of the object “content”: the Mesh datablock for the geometric objects, the Lamp parameters for 

a light source, or details of the Camera projection for a camera, or other datablock types (Curve, for ex-

ample). 

 Material 

 

General properties of the material datablock, assigned to a mesh or an object (its color and specularity, 

transparency, and many other parameters) 

 Texture 

 

Managing the material textures. These are raster images, used to recreate minor irregularities in the 

surface (rivets, screws, panel joints). They are also used to alter locally many other material properties - 

like the color (camouflage, dirt). This context is used for the Blender renderer only. 

 Particles 

 

We will use this section at the end of the book to create some grass on the airfield. 

Table 2.5.1 Short description of selected panel sets 

If such terms as “material” or “texture” are abstract for you at this moment — do not worry, I will explain their 

meaning in the further chapters. Table 2.5.1 is placed here just to let you know what to do when I write: “In the 

Properties window, switch to the Material set”, or “switch to the Material context”. (It means the same).  

 

Datablock:  the 
Sun lamp 

Datablock: 
Camera.Tracked.001 

a) b) Lamp 

 

Camera 
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Excuse me if this introduction was a bit lengthy.  I wanted to bring your attention to details of panel handling in 

the Properties window. In fact, the generation of the final image or animation in Blender can be reduced to click-

ing a single button (in a moment I will show you which one). Before I do it, we will discuss some options of the 

rendering process. On this occasion I will explain briefly some other details of Blender controls. 

 
Switch into the Render context. Figure 2.5.9 with this example shows the basic types of GUI controls used in 

Blender: 

  

                    

Figure 2.5.9 Basic types of Blender controls 

Command buttons (also known as operation buttons) are used to invoke a command (like Render:Image or 

Render:Animation). Do you know that in the original Blender terminology each control is referred to as some 

kind of a “button”? The origins of this tradition are lost in the darkness of history. I think that because of this no-

menclature the control labels are placed inside the text and numeric fields (see Figure 2.5.9a). You have to 

adapt to this convention. Fortunately, the checkboxes (referred also as toggle buttons) do not adhere to this 

style1.  

 
Below the label of the Dimensions panel there is a dropdown list (menu button) named Render Presets. You can 

click it (with the LMB , of course) and select one of the typical render formats (Figure 2.5.9b)2. On the other pan-

els you can see a few dropdown lists, used to select one of the possible options (e.g. the list of the 

Render:Display modes). When the list of the alternatives is short enough, Blender uses toggle buttons, instead 

of a dropdown (for example, to choose the number of samples in the Anti-Aliasing panel). 

                                                      
1 However their current shape is a relatively new modification, which appeared in Blender 2.5. In the previous versions they looked like 

toggle buttons (highlighted when turned on). Thus the role of these controls was not so obvious, especially at first glance you could confuse 

them with command buttons. The current checkboxes are more readable for new users, because they comply with the convention of popular 

windowing systems. 
2 Notice that when you select an item from the Render Presets list, the content of the Dimensions panel will change. The Resolution, Aspect 

Ratio, Frame Range, Frame Rate fields will be updated according the settings from the selected item. You can also use the [+] button (on 

the right side of this dropdown) to add a new item to this list. It will copy the parameters currently displayed in the panel. (I have not used it). 

Command 
button 

Numeric field 
(standard) 

Dropdown list  

Numeric field 
(slider)  

Inactive controls 
are grayed out 

Checkbox 

This checkbox 
enables this 
whole panel 

Radial (toggle) 
buttons 

Selected option  

Click on this field to pull 
down the list containing 

various alternate options 

a) b) 

Blender shortens the 
too long labels — make 
the Properties window 
wider, to change this O: 
into Old: 
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Sometimes the dropdown can have several columns. I will show it on another example. Scroll the panels of the 

Render section slightly upward to reveal the Output panel, placed at the end of this panel set. It contains a 

dropdown list where you can set the default file format for the rendered image (Figure 2.5.10):  

 

                                                              

Figure 2.5.10 Selection of the default raster image file format — an example of multi-column dropdown list 

 The raster file format, set here, applies to all raster images, generated by Blender. Even the simple “dump” 

of the current  Blender screen ( Ctrl - F3 ) is saved in the format specified by this field! 

 
When you select the Jpeg file format, you should also set the value specified by its Quality field (Figure 2.5.10). 

The Jpeg format is one of the so-called destructive compression formats, because it reduces the file size at the 

price of image quality. Using the Quality value (expressed as a percentage) you can control the compromise 

between the file size and quality of the image. When Quality = 100%, there is no image degradation (each pixel 

is stored separately). Such a file will have the largest size, of course. Personally, I advise to set the Quality value 

to 85%-95%. Such a setting creates relatively small file that still contains a picture of a decent quality. 

 
How to enter the new Quality value? Probably it is obvious for the most readers, but I will describe it here in a 

few words. Perhaps you may learn some useful details this way. 

The Output:Quality field is a slider, i.e. its values are restricted to a specific range (between 0% and 100%, in 

this case). Blender fills the slider with two colors, where the border of these colors corresponds to the current 

value. You can change the slider value dragging the mouse over it (with LMB  pressed — Figure 2.5.11): 

 

 

 

                                               

Figure 2.5.11 Changing the value of a numerical field with the mouse 

Of course, you can also change this field by typing an exact value. Just click it once (with the LMB ) or press the 

Enter  key, to let it receive the keyboard focus. Then you can type a number (Figure 2.5.12): 

 
 

 

                                              

Figure 2.5.12 Changing the value of a numerical field by typing 

What is interesting — you can also type an arithmetic expression, like “100 / 3”, and even something with 

brackets! It works like a calculator, substituting the result as the new value of this numeric field. 

The dropdown list 
can have more 
than one column! 

Press LMB  over 

the slider… 

… and drag it! 

Click LMB  once, then type 

the new value… 

… and the field 
is updated! 

… press Enter , 

when it is finished… 
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More often encountered is the version with “arrows”.  Such a field may have unrestricted range of its values. In 

the Dimensions:Resolution area you can find a group of three numeric fields, controlling the size of the ren-

dered image. The two upper ones — X and Y — are the standard “arrows” fields, determining the width and 

height of the result image (in pixels)1 (Figure 2.5.13): 

 

                                                                               

Figure 2.5.13 Two methods of changing the value of a numeric field 

Clicking LMB  on the “arrows” on the left and right sides of a field, you can increment and decrement its value 

(Figure 2.5.13a). Each click changes it by a fixed step (in this case — by 1 pixel). It is a good method for small 

corrections, but if this box has to contain a completely different value — you better type it directly (as shown in 

Figure 2.5.13b and Figure 2.5.12).  

 

 To cancel current edit operation (in the situation as in Figure 2.5.13b), press the Esc  key.  

 
You can use each numeric field as a slider, by dragging the mouse (holding LMB  down) over its area (see Fig-

ure 2.5.11). If you want to change it incrementally, by the fixed steps — hold down the Ctrl  key. (This is the 

same convention as for the object transformations — see page 53, Figure 2.4.7). You can also use the mouse to 

change simultaneously two or more related numeric fields (usually they are coordinates — Figure 2.5.14): 

 

                                                                  

 

Figure 2.5.14 Changing simultaneously two related numeric fields 

 
Let’s return for a moment to the Render:Output panel, because it contains yet another type of the input field: a 

textbox  (Figure 2.5.15).You can enter a new value into a textbox in the same way as we did for the numeric 

field — click it with LMB , type the new text, and then press the Enter . The typical text editor operations are also 

available here: you can select and delete any fragment of the text, you can also copy it ( Ctrl - C ) or paste ( Ctrl -

V ) from the clipboard.   

 
Note that the text control in Figure 2.5.15 is an example of a 

“specialized” field to select the file paths. On its right side there 

is a little open folder icon. When you click it, you will open the file 

selection window (similar to that one described on page 256). 

You can select a directory in that window. Of course, you can 

also simply type the entire path into this field. Note also that it 

starts with double slash (“//”) by default. This is so-called “rela-

tive path marker”.  Reading this entry, Blender replaces “//” with 

its initial path — usually the folder that contains the currently 

opened file.  

 

                                                      
1 The slider located below X and Y fields allows you to get smaller render version. It is very useful for testing. The rendering time is propor-

tional to the number of pixels of the rendered image. To save your time, test the renders on the images of 50% or 75% of the final size. 

 

Figure 2.5.15 Example of a textbox (it is a special-

ized one, for the file or folder path) 

You can also type 
it here 

Clicking ( LMB ) on 

these arrows, you can 
increment or decrement 
the value of this control 

b) a) 

 

A text field.  
(This is the folder and the 
file name prefix of the 
eventual animation files) 

This button opens a folder 

selection window 

If you release LPM  immediately — you 

can enter the value using keyboard 
 

To alter both values, hold LPM  down and 

move the mouse horizontally  
 

Holding LPM  down, use mouse to drag 

the selected (darker) area down  
 

a) b) c) 
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The relative path allows you to easily move the folder with the Blender model and all associated files from one 

disk location into another. With the consistent use of the tag “//” at the beginning of each referenced file path, 

there is no risk that Blender will have problems with finding any of the related files (texture images, for example) 

in such a new place. 

 
I think that this will end our introduction to the Properties window and the Blender GUI controls. (Some of its 

panels contains also list controls — but I decided to describe such a complex GUI item in a separate section, 

which you can find on page 288). During the course of this introduction we have changed the default output 

image format to Jpeg (see page 65, Figure 2.5.10). We have also increased (in the Dimensions panel) the 

height of the rendered image to 1024px (see page 66, Figure 2.5.13). Have you noticed that this immediately 

changes the proportions of the camera frame, in the 3D View? 

 

 In Blender there is almost no “OK.” nor “Accept” buttons. Everything what you set in its Properties window 

or on the shelves (Tool Shelf, Property Shelf), is immediately reproduced on the scene. 

 
In principle, such an instant effect is very convenient. It is based on the assumption that the screen refresh time 

(of all Blender windows) is very short. This assumption may be false, when your computer does not have any 

special graphics accelerator. When the CPU has to draw hundreds thousands of faces of such a model like this 

La-5 in the three different 3D windows, you will observe “resistance” of the slider your are moving. (The values 

displayed in the control will not change immediately). This is because any change of the GUI control forces 

Blender to redraw this model in every 3D View window! This is not a big obstacle, but you can reduce these lags 

by minimizing the number of displayed faces. For example — you can work only on the necessary layers, hiding 

all the others (see page 38, Figure 2.2.4). 

 
The updated Render settings, are ready for generation of the final picture of this La-5. Before you click the final 

button, make sure that at least the following layers:  are turned on. (You can check it also on 

the 3D View window header. If you forget to turn layer 11 on, you will not see the wing nor the fuselage).  

 

 Blender always renders contents of the visible layers only! 

 
Finally — let’s do it! Click the Render:Image button (Figure 2.5.16).  (You can 

also use its keyboard shortcut — the F12  key). Blender will display on the 

whole screen a new UV/Image Editor window. (It works this way, when you set 

the Render:Display dropdown to Full Screen mode — see Figure 2.5.16. Feel 

free to check the other possibilities from this list!). At the beginning the dis-

played image is completely black, then something appears (Figure 2.5.17): 

 

    

Figure 2.5.17 The UV/Image Editor window during rendering 

 

Figure 2.5.16 Starting the rendering 

Click this button 

Click this button to 
cancel (stop) 
current rendering 

This is the progress bar of the 
rendering process 
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Blender renders the image in a non-blocking manner (more precisely: it is calculated by separate program 

threads). This allows its screen to respond to user commands. For example — you can stop this process at any 

time using the button located at the top of the screen, in the Info window header (Figure 2.5.17). 

Finally you should get a result like in Figure 2.5.18: 

 

 

Figure 2.5.18 Image window after rendering 

To save the rendered image on the disk – press the F3  key (or invoke the ImageSave a Copy command). It 

opens the file save window (see page 259). There you can determine its name and location. (In this window you 

can also change the default file format — from the Jpeg to PNG, for example).  

 

If you want to get the motion blur effect of rotating propeller blades — turn on in the Render panel the Motion 

Blur option (Figure 2.5.19a). Then restart the rendering and patiently wait for the ultimate result: 

 

 

Figure 2.5.19 The same image, but with blurred propeller blades 

Click this button, to 
close this window and 
restore the previous 
screen layout 

The generated image is 
always stored under the 
Render Result name 

Image selection dropdown 
(allow to select any of the 
currently loaded images) 

Turn on the Sampled 
Motion Blur option 

Fragment of the Render 

section: 

a) b) 
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Why I have mentioned patience? Because in the case of this Blender Renderer engine motion blur effect has 

been obtained by the simplest, but most computationally expensive method. The Sampled Motion Blur renders 

as many images as you have entered in the Sampled Motion Blur:Motion Samples field (in this case it is 16 — 

see Figure 2.5.19a). Each of them corresponds to the subsequent animation frame. Then they are joined (aver-

aged), producing the motion blur effect. 

My computer renders a single image of this La-5 (like in Figure 2.5.18) in 34s. When I turn on the Sampled 

Motion Blur option, it renders the final image for 16 x 34s, that is 9 minutes. This period increases in proportion 

to the number of pixels (i.e. the image surface), and is longer for the larger images. A better method of obtaining 

the motion blur effect for the spinning propeller is described in the chapter on the composition, at the end of this 

book (see Volume IV). 

 

Summary 

 Controls in the Properties window are grouped into panels (page 60) — as in the window panes (toolbox-

es); 

 Panels are grouped into contexts — the thematic sets, prepared for different types of scene data (page 60, 

63); 

 You can select the current context using the toggle buttons, located on the Properties window header (page 

60, 62); 

 Blender displays only those context toggle buttons, that are appropriate for the current active object (page 

62); 

 You can shift the content of the Properties window up and down (page 61). This way each context is not 

restricted by the screen height and can contain more panels. Some of them are hidden “below” the window 

edge; 

 You can move the individual panels (i.e. change their order in the panel set — page 61) and fold them 

(page 60). These settings are stored individually in each Blender file; 

 The basic Blender controls types are the command button (operation button – page 64), dropdown list 

(menu button — page 64, 65), checkbox and radio buttons (or toggle buttons — page 64), numeric field 

(numeric button — page 65, 66), and text input field (text button — page 66); 

 Everything you change in the Properties window is immediately visible in the model or scene. Thus there 

are no OK or Accept buttons in Blender, as seen in the dialog boxes of other programs; 

 To render the scene, click the Render:Image button (page 67);  

 You can save the currently rendered image using the ImageSave command (shortcut: F3  — page 68); 

 Special effects, like motion blur, may require significantly longer rendering time (page 68); 

 

 



This is end of this excerpt. If you want to learn more on: 

 how to create/modify such a model; 

 how to apply a different camouflage; 

 how to use it to create a stunning historical scene; 

see the full edition of this book: 
 

 

“Virtual Airplane” describes how to create the aircraft 

shown on its cover. It starts with the very basics, and 

gradually introduces the Reader into the complete 

workflow. 

 
This guide is probably the most comprehensive book 

on this subject. It contains 1339 pages, 2440 illustra-

tions. “Virtual Airplane” is available in the most popular 

e-book formats: 

 PDF; 

 EPUB (for IPads); 

 MOBI (for Amazon Fire and Android tablets); 

 
You can find more about this book on: 

http://airplanes3d.net 

 

 

The complete guide was so thick that it is also available as four separate volumes. You can pick from 

them the ones you are most interested in: 
 

 

I Preparations (pages: 168, illustrations: 227) 

Preparation of reference drawings, required to create 

the model. It utilizes GIMP and Inkscape (in this part 

we do not use Blender). 

 

 

II Modeling (pages 444, illustrations: 771) 

Describes how to form the model, using the previous-

ly prepared plans and photographs. It begins from a 

general introduction to this program. Then we will 

start to model the easiest parts, gradually introducing 

more advanced techniques.  

 

III Materials and Textures (pages: 636, illustrations: 

1110) 

Preparation of basic materials and their textures, and 

arrangement of a typical flight scene. It uses the new 

Cycles rendering engine. 

 

 

IV Detailing and Rendering (pages: 523, illustrations: 

1000) 

This volume discusses creation of various aircraft 

parts, especially of the cockpit and undercarriage. At 

the end it shows the composition of exemplary 

scenes in the flight and on the ground.  

http://airplanes3d.net/wm-000_e.xml
http://airplanes3d.net/wm-000_e.xml
http://airplanes3d.net/wm-000_e.xml#excerpt1
http://airplanes3d.net/wm-000_e.xml#excerpt1
http://airplanes3d.net/wm-000_e.xml#excerpt2
http://airplanes3d.net/wm-000_e.xml#excerpt2
http://airplanes3d.net/wm-000_e.xml#excerpt3
http://airplanes3d.net/wm-000_e.xml#excerpt3
http://airplanes3d.net/wm-000_e.xml#excerpt4
http://airplanes3d.net/wm-000_e.xml#excerpt4


 

In the 20th century you could make an aircraft model from 

paper or plastic. In the 21st century the time has come for 

yet another variation of this hobby: computer models. The 

birth of this new branch of scale modeling passed unno-

ticed. Few people could spend several thousand dollars 

of their private money for buying a complete 3D design 

environment just for amusement. During the first years of 

this century the only alternative was to use an “inappro-

priate” software — nothing to boast about... So the first 

enthusiasts were quietly sitting at their monitors, creating 

their models and learning from own mistakes.  

 
The times are changing, and now all the necessary soft-

ware is available for free (it is GPL-licensed). So if you 

bought your computer less than 6 years ago, you have 

everything you need to get started! This book provides the 

essential know-how. I will show you step by step, how to 

make such models as the P-40 shown on this cover.  

 
“Virtual Airplane” was written not only for the scale mod-

elers. It may also be useful to all who want to learn the 

three most popular Open Source graphic programs: 

Blender, GIMP, and Inkscape.   

ISBN:     -  -      - -   

 

A P-40B from the 3rd squadron of AVG („Hell’s Angels”), Kunming 1942. (Background photo: © Tomo Yun, www.yunphpto.net) 

Visit www.airplanes3d.net  to ask a question or obtain free trails!  

 

http://www.airplanes3d.net/wm-000_e.xml

